IBM Rational Directory Server
Installation Guide
Release 5.1.0.2
Before using this information, be sure to read the general information under Appendix, “Notices” on page 45.

This edition applies to VERSION 5.1.0.2, IBM Rational Directory Server and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2006, 2010

US Government Users Restricted Rights—Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
# Table of contents

## About this manual
- Contacting IBM Rational Software Support .................................................. 2
- Prerequisites ........................................................................................................ 2
- Submitting problems ............................................................................................. 2
- Conventions used in this guide ............................................................................. 5

## Introduction
- Obtaining the RDS software ................................................................................ 7
- Installation sequence ............................................................................................. 7
- Remote installation of RDS ................................................................................... 7
- Types of RDS installations .................................................................................... 8
- Preparing installation information ......................................................................... 8
- Frequently Asked Questions .................................................................................. 9

## Server Installation
- System requirements ............................................................................................. 13
  - Industry standards ............................................................................................... 13
  - Operating system requirements ......................................................................... 13
  - Disk space and memory requirements ................................................................ 15
- Before installing RDS ............................................................................................. 15
- RDS 5.1 server ....................................................................................................... 15
- Shell requirements ................................................................................................. 15
- Root settings .......................................................................................................... 16
- Libraries and utilities ............................................................................................ 16
- What is not supported ............................................................................................ 16
  - Console mode installation .................................................................................. 16
  - NFS mounted system .......................................................................................... 16
- Installing the RDS .................................................................................................. 17
- Post installation instructions .................................................................................. 26
1

About this manual

This manual guides you through the IBM® Rational® Directory Server (RDS) installation and uninstallation. It contains the following sections:

• Introduction
• Types of RDS installations
• Preparing installation information
• Server Installation
• Server Removal
• Client Installation
• Client Removal
• Troubleshooting RDS

RDS documentation

This section provides the information on the related documents available for RDS. The following RDS documents are available on the Product Support Web site, http://www.ibm.com/software/rational/support/

<table>
<thead>
<tr>
<th>Document name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Rational Directory Server Installation Guide</td>
<td>Provides information about how installing RDS.</td>
</tr>
<tr>
<td>IBM Rational Server Product Manual</td>
<td>Provides detailed information about RDS features supported in this release.</td>
</tr>
<tr>
<td>IBM Rational Server Administration Manual</td>
<td>Provides information about RDS administration.</td>
</tr>
</tbody>
</table>
Chapter 1: About this manual

Contacting IBM Rational Software Support

If the self-help resources have not provided a resolution to your problem, you can contact IBM® Rational® Software Support for assistance in resolving product issues.

Note If you are a heritage Telelogic customer, a single reference site for all support resources is located at http://www.ibm.com/software/rational/support/telelogic/

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active Passport Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive software licensing and software maintenance (product upgrades and technical support) offering. You can enroll online in Passport Advantage from http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage FAQs at http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are asked to supply a severity level. Therefore, you need to understand and assess the business impact of the problem that you are reporting.
Use the following table to determine the severity level.

<table>
<thead>
<tr>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The problem has a <em>critical</em> business impact: You are unable to use the program, resulting in a critical impact on operations. This condition requires an immediate solution.</td>
</tr>
<tr>
<td>2</td>
<td>This problem has a <em>significant</em> business impact: The program is usable, but it is severely limited.</td>
</tr>
<tr>
<td>3</td>
<td>The problem has <em>some</em> business impact: The program is usable, but less significant features (not critical to operations) are unavailable.</td>
</tr>
<tr>
<td>4</td>
<td>The problem has <em>minimal</em> business impact: The problem causes little impact on operations or a reasonable circumvention to the problem was implemented.</td>
</tr>
</tbody>
</table>

2. Describe your problem and gather background information. When describing a problem to IBM, be as specific as possible. Include all relevant background information so that IBM Rational Software Support specialists can help you solve the problem efficiently. To save time, know the answers to these questions:

- What software versions were you running when the problem occurred?
  To determine the exact product name and version, use the option applicable to you:
  - Start the IBM Installation Manager and select **File > View Installed Packages**. Expand a package group and select a package to see the package name and version number.
  - Start your product, and click **Help > About** to see the offering name and version number.
- What is your operating system and version number (including any service packs or patches)?
- Do you have logs, traces, and messages that are related to the problem symptoms?
- Can you recreate the problem? If so, what steps do you perform to recreate the problem?
Chapter 1: About this manual

- Did you make any changes to the system? For example, did you make changes to the hardware, operating system, networking software, or other system components?
- Are you currently using a workaround for the problem? If so, be prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM Rational Software Support in the following ways:

     
     For more information about opening a service request, go to [http://www.ibm.com/software/support/help.html](http://www.ibm.com/software/support/help.html)
     
     You can also open an online service request using the IBM Support Assistant. For more information, go to [http://www.ibm.com/software/support/isa/faq.html](http://www.ibm.com/software/support/isa/faq.html).
   
   - **By phone**: For the phone number to call in your country or region, go to the IBM directory of worldwide contacts at [http://www.ibm.com/planetwide/](http://www.ibm.com/planetwide/) and click the name of your country or geographic region.
   
   - **Through your IBM Representative**: If you cannot access IBM Rational Software Support online or by phone, contact your IBM Representative. If necessary, your IBM Representative can open a service request for you. You can find complete contact information for each country at [http://www.ibm.com/planetwide/](http://www.ibm.com/planetwide/).
## Conventions used in this guide

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Italic</em></td>
<td>Used for book titles and terminology.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Used for items that you can select and menu paths, also used for emphasis.</td>
</tr>
<tr>
<td><em>Courier</em></td>
<td>Used for commands, file names, and directory paths. Represents command syntax to be entered verbatim. Signifies computer output that displays on-screen.</td>
</tr>
<tr>
<td><em>Courier Italic</em></td>
<td>Represents values in a command string that you supply. For example, <em>(drive:\username\commands).</em></td>
</tr>
</tbody>
</table>
Introduction

RDS is a single enterprise directory solution designed for user authentication and administration for IBM® Rational® Solutions for Enterprise Lifecycle Management tools. RDS allows the users to log on using the same credentials across Enterprise Lifecycle Management tools for which they have authorized access.

RDS is designed to support a wide range of platforms. For more information on the platform support see Operating system requirements (page 13).

The RDS comes with the Graphical User Interface (GUI) based client application IBM® Rational® Directory Administration (RDA), that can be installed separately. For information on installation instruction and procedure, refer to Installing the RDA (page 31).

Note   The RDS 5.1.0.2 should be installed on an existing RDS 5.1 server. The RDS 5.1.0.2 automatically updates both server and client. You can also install the client separately by installing the RDA.

Obtaining the RDS software

You can download the RDS from the support site or from the zip distribution. After downloading the RDS, make sure you verify the MD5 checksum available under the support site, http://www.ibm.com/support/fxcentral/ matches the downloaded installer. This will ensure that the downloaded installer is not corrupted.

Installation sequence

The RDS must be present in the system for the other tools to connect. You can install the RDS prior to or post other tools installation.

Remote installation of RDS

RDS requires graphical X environment for installation. In case of remote installation by X environment, ensure that DISPLAY environment variable should be set appropriately as, $ export DISPLAY=localhost:0. For more information, see the platform specific manual for details.
Types of RDS installations

There are two types of RDS installations:

<table>
<thead>
<tr>
<th>Installation type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Installation</td>
<td>Installs RDS 5.1.0.2 fix pack on an existing RDS 5.1 server. The RDS provides user authentication and administration across Enterprise Lifecycle Management tools using the same credentials. The server installation also provides the option to install Web RDA client. However, you can choose to install that separately.</td>
</tr>
<tr>
<td>Client Installation</td>
<td>Installs the client (RDA) on a local machine. The client can access the server on the local machine or on a network.</td>
</tr>
</tbody>
</table>

Preparing installation information

Preparing installation information in advance can help you to complete the installation process quickly. Before starting the installation, consider creating a worksheet to record the basic installation information, as described for a typical installation in the following table..

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>Same as your existing RDS 5.1 server.</td>
</tr>
<tr>
<td>Directory server port number</td>
<td>Default LDAP port. Use the same port number given at the time of RDS 5.1 installation.</td>
</tr>
<tr>
<td>Secure port number</td>
<td>(Default LDAP SSL port. Use the same secure port number given at the time of RDS 5.1 installation.</td>
</tr>
<tr>
<td>Directory administrator password</td>
<td>This must be the tdsadmin password given at the time of tdsadmin user creation.</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

1. Which are the external LDAP servers supported by RDS?

   Sun Java\textsuperscript{\textregistered} System Directory Server and Microsoft\textsuperscript{\textregistered} Active Directory Server.

2. What is the schema required by RDS in the external corporate server?

   The user information are extracted from the corporate servers based on the \texttt{person/inetOrgPerson} schema class and the primary attributes \texttt{cn}, \texttt{sn}, email, \texttt{uid}, givename, \texttt{telephoneNumber}, mail, facsimile\texttt{TelephoneNumber}, description, postal\texttt{Address}, and \texttt{sAMAccountName}.

   The group information are extracted based on the \texttt{group/groupOfUniqueNames} schema class and the attributes \texttt{member/uniqueMember}, description.

3. Do we need an Administrator privileges to create a partition?

   You need a corporate LDAP server user with a \texttt{Read} access to the search bases specified in the partition.

4. I cannot use RDA on Solaris to create a partition with SSL enabled?

   This is a known limitation. You need to install RDA on Windows as a workaround.

---

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory administrator ID</td>
<td>exttt{tdsadmin} (set by default)</td>
</tr>
<tr>
<td>Installation directory</td>
<td>Same as your existing RDS 5.1 server.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>- \texttt{/var/IBM/Rational/RDS_5.1}</td>
</tr>
<tr>
<td></td>
<td>or any other specified path.</td>
</tr>
<tr>
<td></td>
<td>- Tivoli directory server binary is</td>
</tr>
<tr>
<td></td>
<td>always installed under \texttt{/opt/IBM/ldap/V6.2}</td>
</tr>
</tbody>
</table>

---
5. Why DOORS do not show up a user after changing the name of the user from one ou to another in the corporate LDAP?

If the name of a user (firstname, lastname, cn etc.) is changed keeping the same UID, or if a user is moved from one OU to another in the corporate LDAP, DOORS may not show up the user. The reason is, the RDS has already created an extended user object with the uid as the user logon name (based on the logon attribute selected in the corporate partition) and tdsCorporateDn as the corporate DN of the user. If the corporate DN of the user changes in the corporate LDAP server, RDS will try to recreate the extended user object with the same user logon name (which is not changed in corporate LDAP) and would fail, as the user object with the same logon name already exists in the corporate LDAP. Hence, the particular user would not be shown in DOORS.

To solve this issue, it is recommended to modify the required attributes of the extended user object in RDS. Deleting the extended user object also solves the issue but it may delete the DOORS specific values for that user object, which may lead to information loss.

6. Will error opening *.cat files messages affect functionality of RDS 5.1 for Tivoli in any way?

No. You can ignore such error messages, they keep coming because of a minor localization issue with Tivoli which will no way affect RDS and its functionalities.

7. Is RDS supported on VMWare?

Currently, the RDS is not supported on a virtual environment.

8. How do you change the Webserver port from 8080 to any other values for IBM Rational Directory Administration (RDA)?

To change the default port number:

a. Edit the following lines in the Server.xml file located under

   `<RDS_HOME/RDA_HOME>\WebAccessServer\apache-tomcat-6.0.16 (-6.0.24 for 5.1.0.1 and 5.1.0.2)\conf` folder:

   ```xml
   <Connector port="8090" protocol="HTTP/1.1"
   connectionTimeout="20000"
   redirectPort="8443" />
   <!-- A "Connector" using the shared thread pool-->
   ```

   ```xml
   <Connector port="8090" protocol="HTTP/1.1"
   connectionTimeout="20000"
   redirectPort="8443" />
   <!-- A "Connector" using the shared thread pool-->
   ```
b. Restart the RDA for the changes to take effect.

Note The new port number is changed to 8090 in the above example.
This chapter contains the installation instructions for installing RDS on Solaris, and Linux platforms.

This chapter contains the following sections:

- System requirements
- Before installing RDS
- Installing the RDS
- Post installation instructions

### System requirements

The following section describes the system requirements for the RDS.

#### Industry standards

The RDS is developed based on the following industry standards.

- LDAP v3 operations
- LDAP search filters
- LDAP v3 intelligent referral

#### Operating system requirements

RDS and RDA are supported on the following platforms:

- Sun Solaris 10 operating system 64 bit ( / SPARC Platform)
- Red Hat Enterprise Linux Server 5 operating system 32 and 64 bit
The following table details the list of additional software that must be available in the system.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Supported OS versions</th>
<th>Additional required software</th>
</tr>
</thead>
</table>
| Solaris operating system| Solaris 10 operating system for SPARC®                                              | • The Korn shell is required.  
• `pkgadd` system utility should exist.  
• 64-bit kernel.  
• If raw devices are used, patch 125100-07.                                                                 |
| Red Hat Linux           | Red Hat Enterprise Server 5 for x86 (32 and 64 bit OS)                               | The following packages needs to be installed before installing the Rational Directory Server:  
1. `glibc-devel`  
2. `glibc-headers`  
3. `libaio`  
4. `compat-libstdc++`  
Some of the rpm names of these packages are:  
• `glibc-2.5-18.i686.rpm`  
• `glibc-common-2.5-18.i686.rpm`  
• `glibc-common-devel-2.5-18.i686.rpm`  
• `glibc-headers-2.5-18.i686.rpm`  
• `nscd-2.5-18.i686.rpm`  
The rpm name could end with "i386" based on the hardware details (`/ confirm with command "uname -m"`).  
Libraries `libstdc++` and `libaio.so.1` should exist.  
You might need to upgrade to the latest patch level of these packages. For more information on the patches, see the Red Hat support site at [http://rhn.redhat.com](http://rhn.redhat.com). |
Disk space and memory requirements

Requirement for RDA

Make sure that sufficient disk space is available before installing the RDA. The following table shows the minimum disk space and memory requirements for RDA.

<table>
<thead>
<tr>
<th>Minimum disk space required</th>
<th>Minimum memory required</th>
</tr>
</thead>
<tbody>
<tr>
<td>300 MB</td>
<td>512 MB</td>
</tr>
</tbody>
</table>

Before installing RDS

Before you install the RDS, ensure that the system is equipped with the set of configurations recommended in this manual to avoid any installation errors. You need at least 5 GB of free disk space and at least 1.5 GB free space in /tmp folder.

This section also describes the following settings that must be in place.

- RDS 5.1 server
- Shell requirements
- Root settings
- Libraries and utilities
- What is not supported

RDS 5.1 server

Make sure that RDS 5.1 is present and running in your system before installing the RDS 5.1.0.2. However, it is recommended to stop the RDA web server during the installation.

Shell requirements

The following settings are recommended for Solaris and Linux installation.

- On Solaris 10 - Korn shell (KSH) must be installed on the OS.
- Red Hat 5 - Korn shell is not available by default. Install the ksh on the OS or create a soft link from the zsh to ksh.
Root settings

Both Linux, and Solaris requires root user login to perform the installation and instance creation. You must have root access to start the RDS.

Libraries and utilities

You must install the recommended libraries and utilities. For more information on the required libraries and utilities see, Operating system requirements (page \[13\]).

What is not supported

This section describes the modes or systems that are not supported by RDS. You must not use the modes or systems referred in this section to avoid any installation errors.

This section contains the following components:

• Console mode installation
• NFS mounted system

Console mode installation

The RDS does not support non-graphical or console mode installation. Hence, the options such as -console is not supported by the RDS installer.

NFS mounted system

The RDS installation is not supported on NFS mounted systems. The /usr/local/bin, /opt and the installation location should not be NFS mounted.
Installing the RDS

Install the server as a root user.

To Install RDS, do the following:

1. Unzip the RDS installer in a folder (use unzip or gunzip utilities).
2. Go to the install directory and set the execute permission to RDS.bin
   
   chmod +x RDS.bin
   
   Skip this step for CD and DVD installation.
3. The root user should have write permission to the below directories:
   
   $ /usr/local/bin
   $ /opt
   
   The directories should not be NFS enabled.
4. Path settings:
   
   • Ensure that the utilities: unzip, gunzip, dos2unix, userdel and groupdel are in the system path.
5. The DISPLAY environment variable should be appropriately set for the remote installation.
6. In the **install** directory, type `./RDS.bin` and press **Enter**. The **Introduction** dialog box is displayed.

7. Click **Next**. The **License Agreement** dialog box is displayed.

8. You can save the licence details in a document.

   To copy the license information:
   - Right-click the license window and click **Select All**, and then click **Copy**.
   - Open any file, paste the license information and save the file.
9. Review and click **I accept the terms of the license agreement.**
10. Click **Next**. The **Choose Install Folder** dialog box is displayed.

Click **Choose** to select an existing RDS 5.1 installation location. You can also edit the path manually by clicking anywhere in the text box. To use the default location, click the **Restore Default Folder**. This restores the default location provided by the installer.

![Rational Directory Server 5.1.0.2](image)

**Note** The IBM Tivoli Directory Server folder like `/opt/IBM` etc. are created outside the installation path.
11. Click **Next**.

   The **Tivoli Home Folder** dialog box is displayed.

12. Click **Choose** to specify the directory path where you have installed Tivoli. You can also type the path manually by clicking anywhere in the text box.
13. Click Next. The **Rational Directory Server Configuration** dialog box is displayed. This defines the configuration settings for the RDS.

14. Type the directory server configuration properties.

The field descriptions and the values to be entered in each field are explained in the following table.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>The host name of the computer where the RDS 5.1 is installed.</td>
<td>Enter a valid computer name where the RDS 5.1 is installed.</td>
</tr>
<tr>
<td>Directory Server Port</td>
<td>The port number of the RDS 5.1.</td>
<td>Enter the RDS 5.1 directory server port number.</td>
</tr>
</tbody>
</table>
15. Click Next. Type the Directory Administrator User password.

The field description and the value to be entered in each field is explained in the following table.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Port</td>
<td>The LDAP Secure Socket Layer (SSL) port number. By default, the SSL is enabled by the installer using the secure port number provided during the installation.</td>
<td>Enter the RDS 5.1 secure port number in this field.</td>
</tr>
<tr>
<td>RDS Administrator User ID</td>
<td>The user id for RDS administrator.</td>
<td>The RDS administrator ID is set by default. The administrator ID cannot be modified.</td>
</tr>
</tbody>
</table>
Chapter 3: Server Installation

16. Click Next. The **Pre-Installation Summary** dialog box is displayed. This dialog box shows the installation summary.

17. Review the information, and then click **Install**. The **Install Complete** dialog box is displayed if the installation is successful.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDS Administrator User Password</td>
<td>The password for the RDS administrator user.</td>
<td>Type the <em>tdsadmin</em> user password that was set at the time of Tivoli installation.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The password authentication for RDS administrator user.</td>
<td>Re-enter the password in the Confirm Password field. Both passwords should match for the installation to continue.</td>
</tr>
</tbody>
</table>
18. Click **Done** to exit the installer.
Post installation instructions

This section details the basic checks that you can perform to ensure that the installation has gone through fine.

This section contains the following components:

- Starting the Web Server
- Review log files

Starting the Web Server

After installing RDS, start the Web server using the following command:

**On Solaris:**

```
$> cd <RDS_Home>/WebAccessServer
$> ./Start_RDAWebAccessServer.sh
```

**On Linux:**

```
$> cd <RDS_Home>/WebAccessServer
$> ./Start_RDAWebAccessServer.sh
```

After starting the server, login to RDS, click Help > About and confirm that the client and server version values have changed to 5.1.0.2.

Review log files

1. If the installation is corrupted and the server is not started, review the following log files carefully for any errors.
   - `<RDS_InstallHome>/RDS_5.1.0.2_InstallLog.log`
   - `<RDS_InstallHome>/logs/modify_5.1.0.2.log`
   - `<RDS_InstallHome>/logs/schema-error_5.1.0.2.log`

2. If the log files specify the installation has failed with Tivoli or DB2 errors, look for the server startup errors in `ibmslapd.log`.

*Note* The above listed log files must be sent along with the other relevant information to the support specialist while reporting the errors. For more information on reporting the errors, see [Contacting IBM Rational Software Support (page 2)](#).
Space issues

In case of space issues, delete the log files that are created under `/tmp` folder post installation to gain space. However, this is optional.
4 Server Removal

Removing the RDS

This chapter describes the steps to remove RDS and Tivoli on all platforms. Remove the server with the same user account that was used for installation.

There is no separate uninstaller for RDS 5.1.0.2. Use the RDS 5.1 uninstaller to uninstall the RDS.

To remove RDS, do the following:

1. Go to the `<RDS_Install_Dir>/UninstallRDS5.1` folder.
2. Type `./UninstallRDS5.1` and press Enter. The Uninstall RDS 5.1 dialog box is displayed.
3. Click Uninstall to remove the RDS.
4. The Uninstaller removes the components one by one.
5. After removing all the components successfully, the Uninstall Complete dialog box is displayed.
6. Click Done exit the installer.

Note Follow the same procedure for uninstalling the RDS on Linux platform.
Client Installation

Rational® Directory® Administration (RDA) is a GUI based client application helps the user to perform day-to-day administration tasks such as creating users, groups, roles, performing searches, migrating data, etc.

Installing the RDA

This section describes the RDA installation on Solaris, and Linux platforms. To start the installation, follow the instructions given below:

To install RDA, do the following:

You first need to set the execute permission for **RDA.bin** inorder to start the installation.

1. Unzip the RDA installer in a folder (use unzip or gunzip utilities).
2. Go to the **install** directory and set the execute permission to **RDA.bin**.
   ```
   chmod +x RDA.bin
   ```

Skip this step for CD and DVD installation.
Chapter 5: Client Installation

2. In the **install** directory, type `.//RDA.bin` and press **Enter** to start the installation. The **Introduction** dialog box is displayed.

![Introduction dialog box](image)

3. Click **Next**. The **License Agreement** dialog box is displayed.

4. You can also save the licence details in a document.

   To copy the license information:
   - Right-click the license window and click **Select All**, and then click **Copy**.
   - Open any file, paste the license information and save the file.
5. Review and click **I accept the terms of the license agreement.**
6. Click **Next**. The **Choose Install Folder** dialog box is displayed.

You can use the default location provided by the installer or click **Choose** to specify a different location. You can also edit the path manually by clicking anywhere in the text box. To use the default location, click the **Restore Default Folder**. This restores the default location provided by the installer.
7. Click **Next**. The **Pre-Installation Summary** dialog box is displayed. This dialog box shows the installation summary.

8. Review the information, and then click **Install**. The **Install Complete** dialog box is displayed if the installation is successful.
9. Click **Done** to exit the installer.

![Installation Complete]

**Note**  The Web Access Server is automatically started as a background process when the web access server is installed. After installation, verify the server is running using the following command:

```
ps -ef | grep tomcat
```

If the tomcat process is not running, see the Troubleshooting RDS (page 41) section for details on starting the server.
6

Client Removal

Removing the RDA

This chapter describes the steps required to remove RDA on all platforms.

To remove RDA, do the following:

1. Go to the <RDA_Install_Dir>/UninstallRDA5.1 folder.
2. Type ./Uninstall_RDA_5.1.0.2 and press Enter. The Uninstall RDA 5.1.0.2 dialog box is displayed.
3. Click Uninstall. The Uninstaller removes the components one by one. The Uninstall Complete dialog box is displayed if the uninstallation is successful.
4. Click Done to exit the installer.
Chapter 6: Client Removal
Launching RDA

This chapter describes how to launch the RDA application.

You can launch the desktop RDA that is installed on a client machine or the Web RDA from any machine by providing the appropriate URL. The Web RDA is supported on Mozilla browser.

**Note** The RDA web server starts automatically during installation.

To start the RDA, do the following:

1. If the RDA web server is not started, run the following command to **start** the web server.
   
   `<RDA_Home>/WebAccessServer/Start_RDAServer.sh`
   
   For example:
   
   `$> /var/IBM/Rational/RDA_5.1.0.2/WebAccessServer/Start_RDAServer.sh`

2. Open the browser and type the URL for the RDS:
   

   For example:
   
   http://rdsserver:8080/webrda/rda

   **Note** The `<hostname>` refers to the name of the server where the RDS is installed.

3. The **RDS Login** dialog box is displayed.
4. On the **Login** dialog box, type the details as:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>URL</strong></td>
<td>The LDAP URL should include a valid server name and a port number that was given at the time of RDS installation. For example: ldap://dirserv:1636. To open the RDS in secure mode, you can include the letter &quot;s&quot; in the ldap URL (where the &quot;s&quot; refers to the secure port), followed by a valid server name and a port number.</td>
</tr>
<tr>
<td><strong>RDS Admin</strong></td>
<td>The admin user name for RDS. The admin user <em>tdsadmin</em> is set by the RDS installer.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The admin password set at the time of RDS installation.</td>
</tr>
</tbody>
</table>

5. Click **Login**.

**Note** To stop the server, use the following command:

```
$> <RDS_Install_Dir>/WebAccessServer/apache-tomcat-6.0.16/bin/catalina.sh shutdown
```
# Troubleshooting RDS

This chapter describes the possible problems and solutions for RDS users.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation was successful but server version is shown as 5.1.</td>
<td>Check the following logs:&lt;br&gt;&lt;RDS_InstallHome&gt;\logs\modify_5.1.0.2.log&lt;br&gt;&lt;RDS_InstallHome&gt;\logs\schema-error_5.1.0.2.log and make sure that all schema updates were successful. If there are any errors, it is possible that either the RDS 5.1 server was not running at the time of installation or an invalid tdsadmin credentials were given at the time installation. Re-install the RDS 5.1.0.2 after starting the RDS 5.1 server and provide valid password for the tdsadmin user.</td>
</tr>
</tbody>
</table>
## Terms and Concepts

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP</td>
<td>Lightweight Directory Access Protocol (LDAP) is a directory service protocol designed to run over TCP/IP and across multiple platforms.</td>
</tr>
<tr>
<td>OS authentication</td>
<td>Operating system authentication is the process of proving the identity of the client user to the directory server based on the operating system log on name.</td>
</tr>
<tr>
<td>PAM</td>
<td>A pluggable authentication modules (PAM) is a set of libraries and services used for authentication.</td>
</tr>
<tr>
<td>SSL</td>
<td>A Secure Sockets Layer (SSL) is a software library that establishes a secure connection between a client and server.</td>
</tr>
<tr>
<td>RDS Client</td>
<td>A RDS client is an interface that requests services or information from a server.</td>
</tr>
</tbody>
</table>
Appendix: Notices

© Copyright 2000, 2010

U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at [www.ibm.com/legal/copytrade.html](http://www.ibm.com/legal/copytrade.html).

Linux is a registered trademark of Linus Torvalds in the United States, other.
UNIX is a registered trademark of The Open Group in the United States and other countries.
Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
Other company, product or service names may be trademarks or service marks of others.
Index

A
additional softwares 14

C
console mode 17
contact information 2

D
default LDAP port 8
default LDAP SSL port 8
disk space 15
display variable 18
document conventions 5
dos2unix 18

G
groupdel 18
gunzip 18

I
IBM Customer Support 2
Installing RDA 31

K
kernel settings 16

L
Launching RDA 39
LDAP 43
libraries 17
log files 27

M
memory requirements 15
modes 8

N
NFS mounted system 17

O
operating system requirement 13
os authentication 43
os versions 14

P
PAM 43
path settings 18

R
RDS Client 43
RDS documentation 1
Red Hat Linux 14
root settings 16

S
secure port number 8
Server port number 8
shell requirement 15
Solaris 14
SSL 43
supported operating systems 13
system requirements 13

T
Types of TDS Installation 8

U
unzip 18
userdel 18
utilities 18